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 الأول: مدخل إلى الإحصاء والمنهجيةالمحاضرة 

يهدف هذا المحور إلى تعريف الباحثين بأساسيات الإحصاء والمنهجية العلمية، مما يساعدهم في تصميم 

 :الأبحاث العلمية وتحليل البيانات بشكل دقيق وموضوعي. سيتم تناول المحور في ثلاثة أقسام رئيسية

 مدخل إلى الإحصاء .1

 المنهجية العلمية في البحث .2

 دور الإعلام الآلي في البحث العلمي .3

: مدخل إلى الإحصاء  أولاا



 تعريف علم الإحصاء وأهميته .1

الإحصاء هو العلم الذي يهتم بجمع البيانات، تنظيمها، تحليلها، وتفسيرها لاستخلاص نتائج ذات دلالة 
 .تساعد في اتخاذ القرارات

 :ث العلميأهمية الإحصاء في البح��

  وتحويلها إلى معلومات مفيدة تنظيم البيانات المعقدةيساعد على. 

  بناءً على نتائج رقمية دقيقة اتخاذ قرارات دقيقةيساهم في. 

  وإثبات العلاقات بين المتغيرات اختبار الفرضيات العلميةيستخدم في. 

 أنواع الإحصاء .2

 :هناك نوعان رئيسيان من الإحصاء في البحث العلمي

 (Descriptive Statistics) الإحصاء الوصفي -أ

 .بطريقة واضحة، دون استخلاص استنتاجات أو تعميمات تنظيم وتلخيص وعرض البياناتيركز على 

 :أدوات الإحصاء الوصفي��

 .عرض البيانات في جداول توضح توزيع القيم:الجداول التكرارية .1

 .ت الدائرية، والرسوم البيانيةمثل المدرج التكراري، المخططا:المخططات البيانية .2

 :مقاييس النزعة المركزية .3
o المتوسط الحسابي (Mean):مجموع القيم مقسومًا على عددها. 

o الوسيط (Median):ًالقيمة الوسطى عند ترتيب البيانات تصاعدياً أو تنازليا. 

o المنوال (Mode):القيمة الأكثر تكرارًا. 

 :مقاييس التشتت .4
o المدى (Range): أكبر وأصغر قيمةالفرق بين. 

o التباين (Variance):مقياس يوضح مدى تشتت البيانات حول المتوسط. 
o الانحراف المعياري (Standard Deviation): الجذر التربيعي للتباين، ويعكس مدى

 .انتشار القيم حول المتوسط

 (InferentialStatistics) الإحصاء الاستدلالي -ب

، وذلك من خلال اختبارات عينةن مجتمع الدراسة بناءً على يسُتخدم لاستخلاص استنتاجات عامة ع

 .الفرضيات

 :أدوات الإحصاء الاستدلالي��

 .للتحقق من صحة الفرضياتANOVAوT-Testمثل اختبار :اختبارات الفرضيات .1
لقياس العلاقة بين متغيرين )مثل علاقة ساعات الدراسة :(Correlation) تحليل الارتباط .2

 .والتحصيل الأكاديمي(

 .لتحديد العلاقة بين متغير تابع ومتغير مستقل:(RegressionAnalysis) تحليل الانحدار .3



 ثانياا: المنهجية العلمية في البحث

 مفهوم البحث العلمي وأهميته .1

عملية منظمة تهدف إلى حل المشكلات والإجابة عن الأسئلة من خلال جمع وتحليل البحث العلمي هو 
 .موضوعيةالبيانات بطريقة 

 :أهمية البحث العلمي��

  وحل المشكلات تطوير المعرفةيساعد في. 

  اتخاذ القرارات العلمية والمهنيةيساهم في. 

  في النتائج الدقة والموضوعيةيضمن. 

 خطوات البحث العلمي .2

 :لكي يكون البحث منهجياً، يجب أن يمر بعدة مراحل منظمة

 :تحديد المشكلة البحثية .1
o سيتم دراستها؟ ما القضية التي 

o لماذا تعتبر مهمة؟ 
o كيف سيتم معالجتها؟ 

 :صياغة الفرضيات .2
o الفرضية الصفرية (H0):تفترض عدم وجود علاقة بين المتغيرات. 
o الفرضية البديلة (H1):تفترض وجود علاقة بين المتغيرات. 

 :اختيار المنهج البحثي .3
o يستخدم لوصف الظواهر دون التدخل فيها:المنهج الوصفي. 
o يعتمد على التجربة لاختبار العلاقات بين المتغيرات:المنهج التجريبي. 

o يعتمد على تحليل البيانات للوصول إلى نتائج:المنهج التحليلي. 

 :تحديد العينة .4
o كل فرد لديه فرصة متساوية للاختيار:العينة العشوائية البسيطة. 

o من كل فئة يتم تقسيم المجتمع إلى فئات، ثم اختيار عينة:العينة الطبقية. 

o يتم اختيار أفراد بناءً على معايير معينة:العينة الغرضية. 

 :جمع البيانات .5
o أكثر الطرق شيوعًا لجمع البيانات من العينة:الاستبيانات. 
o للحصول على إجابات تفصيلية:المقابلات. 

o تستخدم في البحوث الميدانية:الملاحظات. 

 :تحليل البيانات .6
o  يتم ذلك باستخدام البرامج الإحصائية مثلSPSSوExcel. 

 :مناقشة النتائج واستخلاص الاستنتاجات .7
o مقارنة النتائج مع الدراسات السابقة. 
o تفسير النتائج بناءً على الفرضيات. 

 :كتابة التقرير النهائي .8
o يتضمن المقدمة، الإطار النظري، منهجية البحث، النتائج، التوصيات، والمراجع. 

o  



 

 

 

 

 

 المصطلحات الأساسية في التطبيقات الأولية لتحليل البياناتالمحاضرة الثانية 

 :الأهداف

 فهم الأسس والمفاهيم الأساسية لتحليل البيانات. 
 التعرف على أنواع البيانات والمتغيرات المستخدمة في البحث العلمي. 

  البياناتاستيعاب المصطلحات الإحصائية الأولية المستخدمة في تحليل. 

 التعرف على الأدوات المستخدمة في تحليل البيانات مثل SPSS وExcel. 

تحليل البيانات هو عملية تحويل البيانات الخام إلى معلومات مفيدة من خلال تطبيق تقنيات إحصائية 
مختلفة. يستخدم الباحثون تحليل البيانات لاستخلاص استنتاجات، اختبار الفرضيات، واتخاذ قرارات 

مستنيرة. هذه المحاضرة ستغطي المصطلحات الأساسية التي يجب على أي باحث فهمها قبل البدء في 

 .تحليل البيانات

 وأنواعها (Data) المحور الأول: البيانات

كمية يمكن أن تكون البيانات ، هي المعلومات التي يتم جمعها لغرض البحث والتحليل:تعريف البيانات .1

 .)وصفية()عددية( أو نوعية 

 أنواع البيانات .2

 (Quantitative Data) البيانات الكمية -أ

 :تمثل القيم الرقمية التي يمكن قياسها رياضياً، وتنقسم إلى

 بيانات متقطعة (Discrete Data):)بيانات تأخذ قيماً محددة )مثل عدد الطلاب في الصف. 

 بيانات متصلة (Continuous Data):قيمة داخل نطاق معين )مثل  بيانات يمكن أن تأخذ أي

 .الطول والوزن(

 (Qualitative Data) البيانات النوعية -ب

 :تمثل الصفات أو الفئات، وتنقسم إلى

 بيانات اسمية (Nominal Data):)لا يمكن ترتيبها مثل )الجنس: ذكر/أنثى. 



 بيانات ترتيبية (Ordinal Data): ٍمثل مستوى يمكن ترتيبها لكن الفرق بين القيم غير متساو(

 .التعليم: ابتدائي، متوسط، ثانوي(

 

 وأنواعها (Variables) المحور الثاني: المتغيرات

المتغير هو أي خاصية يمكن قياسها أو دراستها في البحث العلميتختلف أنواع :تعريف المتغيرات .1

 .المتغيرات بناءً على دورها في الدراسة

 أنواع المتغيرات .2

 (Independent Variable) المتغير المستقل -أ

 .المتغير الذي يؤثر على متغير آخر في الدراسة، مثل طريقة التدريس وتأثيرها على درجات الطلاب

 (Dependent Variable) المتغير التابع -ب

 .المتغير الذي يتأثر بالمتغير المستقل، مثل تحصيل الطلاب

 (Mediating Variables) المتغيرات الوسيطة -ج

ت تتدخل في العلاقة بين المتغير المستقل والتابع، مثل دافعية الطالب في العلاقة بين طريقة التدريس متغيرا

 .والتحصيل الأكاديمي

 (Control Variables) المتغيرات الضابطة -د

متغيرات يتم تثبيتها لمنع تأثيرها على نتائج البحث، مثل العمر عند دراسة تأثير أساليب التدريس على 

 .يلالتحص

 : الترميز وإدخال البياناتالثالثالمحور 

 (Coding) الترميز .1

 .(2، أنثى = 1تحويل البيانات النوعية إلى رموز رقمية لتسهيل التحليل )مثل: ذكر = ��

 (Data Entry) إدخال البيانات .2

 :تسجيل البيانات في برامج تحليل البيانات مثل��

 Excel (للتحليل الأساسي) 

 SPSS (للتحليل الإحصائي المتقدم) 

 Python/R (للتحليل باستخدام البرمجة) 

 



 : تحليل العلاقة بين المتغيراتالثالثالمحور 

 (Correlation) الارتباط .1

 .(Pearson’s r) بيرسونيقيس قوة واتجاه العلاقة بين متغيرين باستخدام معامل الارتباط ��

 :1و + 1-تتراوح القيم بين ��

 إذا كان r العلاقة طرديةكلما زاد:موجباا X زاد Y. 

 إذا كان r العلاقة عكسية:سالباا (كلما زاد X قل Y). 

 إذا كان r = 0:لا توجد علاقة بين المتغيرين. 

 (Regression) الانحدار .2

 .يستخدم للتنبؤ بقيم متغير بناءً على متغير آخر��

 أسئلة للمناقشة والتقييم

 والنوعية؟ ما الفرق بين البيانات الكمية .1

 كيف يمكن حساب المتوسط الحسابي؟ .2

 ما هو الفرق بين الارتباط والانحدار؟ .3

 ما أهمية الانحراف المعياري في تحليل البيانات؟ .4

 مصادر جمع البيانات في البحث العلميالمحور الرابع 

جمع البيانات هو خطوة أساسية في أي بحث علمي، حيث تعتمد جودة التحليل والاستنتاجات على دقة 

 Primary) مصادر أوليةالبيانات المجمعة. توجد عدة مصادر لجمع البيانات، ويمكن تصنيفها إلى 

Sources)مصادر ثانويةو (Secondary Sources)ليهابناءً على طبيعة البيانات وطريقة الحصول ع. 

: المصادر الأولية  (Primary Sources) أولاا

هي البيانات التي يتم جمعها مباشرة من المصدر الأصلي لغرض البحث. يتميز هذا النوع من البيانات 

 تضم  .بالدقة لكنه يتطلب وقتاً وجهداً أكبر في الجمع والتحليل

 (Surveys& Questionnaires) الاستبيانات .1

 (Interviews) المقابلات .2

 (Observation) الملاحظة .3
 (Experiments) التجارب العلمية .4

 (Official Records & Documents) السجلات والوثائق الأصلية .5

 (Secondary Sources) ثانياا: المصادر الثانوية

عند عدم هي البيانات التي تم جمعها مسبقاً من قبل باحثين آخرين أو مؤسسات رسمية. يستخدمها الباحثون 

 .توفر الوقت أو الموارد لجمع بيانات أولية



تشمل الدراسات الأكاديمية، الكتب (Books &ResearchArticles) الكتب والمقالات العلمية .1
 .المتخصصة، والمجلات العلمية المحكمة

تشمل :(Government& International Reports) التقارير الحكومية والدولية .2

 .الوزارات، المنظمات العالمية )مثل الأمم المتحدة، البنك الدولي(الإحصائيات الصادرة عن 
 Googleمثل(Databases&StatisticalDatasets) قواعد البيانات والمجموعات الإحصائية .3

Scholar ،Scopus ،PubMed، والمواقع الحكومية للإحصائيات. 

المنشورة على الإنترنت،  تشمل المعلومات: البيانات من الإنترنت ووسائل التواصل الاجتماعي .4

 .المدونات، والتعليقات على وسائل التواصل الاجتماعي

 المقارنة بين المصادر الأولية والثانويةثالثا :

 المصادر الثانوية المصادر الأولية العامل

 منخفضة مرتفعة التكلفة

 متوسطة إلى عالية عالية الدقة

 أسرع وأسهل تحتاج وقتاً كبيرًا الجهد والوقت

 قديمة أو حديثة حديثة جداً درجة الحداثة

 مراجعة الأدبيات، التحليلات المقارنة أبحاث ميدانية، دراسات تحليلية التطبيقات

 

 الخاتمة��

اختيار المصدر المناسب لجمع البيانات يعتمد على طبيعة البحث، الموارد المتاحة، والوقت المحدد. 
لكنها مكلفة، بينما توفر المصادر الثانوية بيانات جاهزة ولكنها قد المصادر الأولية تعطي بيانات دقيقة 

 .تكون غير مناسبة لجميع الأبحاث. من الأفضل الجمع بين الطريقتين لتحقيق نتائج دقيقة وموثوقة

 ما هو المصدر الذي تعتقد أنه الأكثر فائدة في بحثك؟ ولماذا؟:سؤال للنقاش��

 جمع البيانات في البحث العلمي أساليبالمحور الخامس :)محاضرة(  

يعُد جمع البيانات خطوة حاسمة في البحث العلمي، إذ يؤثر على دقة النتائج وجودتها. هناك العديد من 

، ويحُدد اختيار الأسلوب المناسب بناءً على طبيعة البحث، نوع البيانات المطلوبة، أساليب جمع البيانات

 .وحجم العينة

 :جمع البيانات إلى قسمين رئيسيينيمكن تصنيف أساليب ��

 .تسُتخدم لجمع بيانات رقمية قابلة للتحليل الإحصائي :(Quantitative Methods) الأساليب الكمية1️⃣

تسُتخدم للحصول على بيانات وصفية تعكس الآراء  :(Qualitative Methods) الأساليب النوعية2️⃣

 .والتجارب

: الأساليب الكمية��  (Quantitative Methods) أولاا



تعتمد على جمع بيانات قابلة للقياس والتحليل العددي. تستخدم في الأبحاث التي تهدف إلى اختبار ��

 .الفرضيات وإيجاد العلاقات بين المتغيرات

 (Surveys& Questionnaires) الاستبيانات .1

 :التعريف��

 .المكتوبة، يتم توزيعها إلكترونياً أو ورقياًأداة لجمع البيانات عبر مجموعة من الأسئلة 

 :أنواع الأسئلة في الاستبيانات��

 أسئلة مغلقة(Yes/No, اختيار متعدد) 🔹سريعة التحليل وسهلة التصنيف. 

 تعطيإجاباتأكثرتفصيلًا ��إجابة نصية( )أسئلة مفتوحة. 

 أسئلة مقياس ليكرت(Likert Scale) 🔹 (5إلى  1الاتجاهات )مثال: من تسُتخدم لقياس الرأي أو. 

 :المزايا��

 .سهولة توزيعها على عدد كبير من الأشخاص✅

 .توفير الوقت والجهد مقارنة بالمقابلات✅

 .Excel أو SPSSإمكانية تحليلها إحصائياً باستخدام برامج مثل ✅

 :العيوب��

 .احتمال عدم دقة الإجابات بسبب سوء الفهم أو التحيز❌

 .لاستجابة منخفضًاقد يكون معدل ا❌

 (Experiments) التجارب العلمية .2

 :التعريف��

طريقة تسُتخدم في الأبحاث العلمية لاختبار العلاقات بين المتغيرات من خلال التحكم في الظروف المحيطة 

 .وإجراء اختبارات مباشرة

 :أنواع التجارب��

 التجربة المعملية (LaboratoryExperiment): محكمة مثل المختبرتجُرى في بيئة. 

 التجربة الميدانية (Field Experiment):تجُرى في بيئة طبيعية. 

 :المزايا��

 .توفر بيانات دقيقة وقابلة للتكرار✅

 .تمكن الباحث من التحكم في جميع العوامل✅

 :العيوب��

 .مكلفة وتحتاج إلى موارد كبيرة❌

 .قد لا تعكس النتائج الواقع الحقيقي تمامًا❌



 (Statistical Data Analysis) البيانات الإحصائية تحليل .3

 :التعريف��

 .استخدام البيانات الرقمية التي تم جمعها مسبقاً من مصادر رسمية مثل التقارير الحكومية أو قواعد البيانات

 :المزايا��

 .توفر الوقت والجهد في جمع البيانات✅

 .بيانات موثوقة إذا كانت من مصادر رسمية✅

 :العيوب��

 .قد تكون البيانات قديمة أو غير محدثة❌

 .قد لا تتناسب مع أهداف البحث الحالي❌

 

 

 (Qualitative Methods) ثانياا: الأساليب النوعية��

 .تعتمد على جمع بيانات وصفية غير رقمية تسُتخدم لفهم الظواهر والسلوكيات��

 (Interviews) المقابلات .1

 :التعريف��

 .مع الأفراد للحصول على معلومات متعمقة حول آرائهم وخبراتهم إجراء محادثة مباشرة

 :أنواع المقابلات��

 مقابلة مهيكلة (Structured Interview):ًأسئلة ثابتة ومحددة مسبقا. 
 مقابلة شبه مهيكلة (Semi-Structured Interview): إطار عام للأسئلة مع مرونة في

 .التعديل

 مقابلة غير مهيكلة (Unstructured Interview):أسئلة مفتوحة ومحادثة حرة. 

 :المزايا��

 .توفر معلومات متعمقة حول الموضوع✅

 .تسمح بالتفاعل المباشر والتوضيح عند الحاجة✅

 :العيوب��

 .تستغرق وقتاً طويلاً ❌

 .قد تتأثر النتائج بتحيز الباحث أو المبحوث❌

 (Observation) الملاحظة .2



 :التعريف��

 .خلال مراقبة سلوك الأفراد أو الظواهر في بيئتها الطبيعيةجمع البيانات من 

 :أنواع الملاحظة��

 ملاحظة مباشرة (Direct Observation):يراقب الباحث المشاركين دون التدخل. 

 ملاحظة بالمشاركة (Participant Observation): ينضم الباحث إلى المجموعة ويشارك في

 .أنشطتها

 :المزايا��

 .دقيقة عن السلوك الفعلي للأفرادتوفر بيانات ✅

 .مناسبة للأبحاث التي تدرس الظواهر الاجتماعية والثقافية✅

 :العيوب��

 .قد تتأثر النتائج بحضور الباحث )تحيز الملاحظة(❌

 .تستغرق وقتاً طويلًا ❌

 (Content Analysis) تحليل المحتوى .3

 :التعريف��

المقالات، المنشورات على وسائل التواصل الاجتماعي، والتقارير تحليل البيانات النصية مثل الكتب، 

 .الرسمية لاستخراج الأنماط والموضوعات

 :المزايا��

 .يمكن تطبيقه على مصادر متعددة مثل الإعلام والصحف✅

 .يوفر فهمًا عميقاً للتوجهات الثقافية والاجتماعية✅

 :العيوب��

 .المختلفة قد يكون عرضة للتفسير الشخصي والتأويلات❌

 .يتطلب وقتاً طويلًا للتحليل والتصنيف❌

 مقارنة بين الأساليب الكمية والنوعية��

 الأساليب النوعية الأساليب الكمية العامل

 وصفية ونصية رقمية وعددية نوع البيانات

 تحليل موضوعي تحليل إحصائي طريقة التحليل

 فهم العوامل النفسية والاجتماعية اختبار الفرضيات وقياس المتغيرات الهدف الرئيسي

 أكثر وقتاً وأعلى تكلفة أقل وقتاً وأرخص الوقت والتكلفة

 المقابلات، الملاحظة، تحليل المحتوى الاستبيانات، التجارب، تحليل البيانات مثال على الأدوات



 كيفية اختيار أسلوب جمع البيانات المناسب؟��

 :منهايعتمد الاختيار على عدة عوامل، ��

 هل يحتاج إلى بيانات رقمية أم وصفية؟:هدف البحث✔

 هل ستجمع بيانات من عدد كبير من المشاركين؟:حجم العينة✔

 هل لديك الوقت والموارد الكافية؟:الإمكانات المتاحة✔

 هل تحتاج إلى بيانات معمقة أم تحليل إحصائي؟:درجة الدقة المطلوبة✔

 الخاتمة��

يانات خطوة محورية في نجاح البحث العلمي، إذ يؤثر على دقة النتائج وتحليلها. يعد اختيار أسلوب جمع الب

 .يفُضل في بعض الحالات الجمع بين الأساليب الكمية والنوعية للحصول على رؤية أكثر شمولًا ودقة

 ��برأيك، ما هو الأسلوب الأنسب لجمع البيانات في الأبحاث التربوية؟ ولماذا؟:سؤال للنقاش��

 أنواع العينات في البحث العلميالمحور السادس 

تمثل هذا  عينةعند إجراء بحث علمي، من الصعب دراسة جميع أفراد المجتمع المستهدف، لذا يتم اختيار 

 .المجتمع. يهدف اختيار العينة إلى جمع بيانات دقيقة تعُبر عن المجتمع بأكمله، مع تقليل التحيز والخطأ

 :إلى قسمين رئيسيين أنواع العيناتتنقسم ��

يتم اختيار الأفراد بشكل عشوائي، مما يمنح كل فرد  :(ProbabilitySampling) العينات الاحتمالية1️⃣
 .فرصة متساوية للاختيار

لا يتم اختيار الأفراد عشوائياً، بل وفقاً  :(Non-ProbabilitySampling) العينات غير الاحتمالية2️⃣

 .لاعتبارات الباحث

 :   )ProbabilitySampling(العينات الاحتماليةأولاا

 .يتم اختيار الأفراد من المجتمع بطريقة عشوائية، مما يزيد من إمكانية تعميم النتائج

 (Simple RandomSample - SRS) العينة العشوائية البسيطة .1

ايتم اختيار الأفراد من المجتمع :التعريف استخدام برامج  ، مثل السحب بالقرعة أوبطريقة عشوائية تماما

 .حاسوبية لاختيار الأفراد

 .تقلل من التحيزكما .تعطي فرصة متساوية لكل فرد ليكون جزءًا من العينة:المزايا

 .قد تكون مكلفة وصعبة التنفيذ، خاصة مع المجتمعات الكبيرة: العيوب

يمكنك استخدام برنامج طالب عشوائياً،  100طالب في مدرسة، وتريد اختيار  1000إذا كان لديك :مثال��

 .حاسوبي لاختيارهم دون تدخل شخصي

 (StratifiedRandomSample) العينة العشوائية الطبقية .2



وفقاً لخاصية معينة )مثل الجنس أو المستوى التعليمي(، (Strata) طبقاتيتم تقسيم المجتمع إلى :التعريف

 .بشكل عشوائيثم يتم اختيار أفراد من كل طبقة 

 .تقلل التحيز في اختيار العينةكما .تعطي تمثيلًا دقيقاً لكل فئة داخل المجتمع:المزايا

 .تتطلب معرفة مسبقة بتقسيم المجتمع:العيوب

 :مثال��

، ثم اختيار عدد ذكور وإناثإذا كنت تبحث عن آراء الطلاب حول مناهج التدريس، يمكنك تقسيمهم إلى 

 .متساوٍ من كل فئة بشكل عشوائي

 (Cluster Sampling) العشوائية العنقوديةالعينة  .3

، ثم يتم اختيار (Clusters) مجموعاتبدلًا من اختيار أفراد منفصلين، يتم تقسيم المجتمع إلى :التعريف

 .بشكل عشوائي للدراسة بعض المجموعات بالكامل

 :المزايا

فة مقارنة بالعينة العشوائية توفر الوقت والتكل✅.مناسبة عندما يكون المجتمع كبيرًا ومتفرقاً جغرافياً✅

 .البسيطة

 .قد لا تكون دقيقة إذا لم تمثل المجموعات المجتمع بالكاملالعيوب

بدلًا من  جامعات معينة عشوائيااإذا كنت تريد دراسة طلاب الجامعات في بلد معين، يمكنك اختيار :مثال

 .اختيار طلاب من جميع الجامعات

 (SystematicSampling) العينة المنتظمة .4

كل خامس شخص، كل عاشر شخص، )فاصل زمني معينيتم اختيار الأفراد بطريقة منتظمة وفق :التعريف

 .(وهكذا

 :المزايا

 .تضمن توزيع العينة على كامل المجتمع✅.سهلة التطبيق وأقل تكلفة من العينة العشوائية البسيطة✅

 .متكرر في المجتمعقد تؤدي إلى تحيز إذا كان هناك نمط :العيوب

 عاشر شخصمنهم، يمكنك اختيار كل  100شخص، وتريد اختيار  1000إذا كان لديك قائمة تضم :مثال

 .من القائمة

  )ProbabilitySampling-Non(ثانياا: العينات غير الاحتمالية

لكنه يكون مفيداً في يتم اختيار الأفراد بناءً على معايير معينة يحددها الباحث، مما قد يؤدي إلى التحيز، 

 .بعض الدراسات الاستكشافية

 (PurposiveSampling) العينة القصدية .1



 .تتناسب مع موضوع البحث معايير محددةيختار الباحث الأفراد بناءً على :التعريف

 .توفر معلومات عميقة حول موضوع البحث .مفيدة عند دراسة مجموعات محددة جداً:المزايا

لا يمكن تعميم النتائج على المجتمع ❌.متحيزة لأن الباحث يختار الأفراد بنفسهقد تكون ❌:العيوب

 .بالكامل

حول منهج تعليمي جديد، يمكنك اختيار  آراء المدرسين ذوي الخبرة العاليةإذا كنت تبحث عن :مثال

 .سنوات خبرة فقط 10المدرسين الذين لديهم أكثر من 

 (Quota Sampling) العينة الحصصية .2

، ثم يتم اختيار عدد معين من الأفراد من كل فئة، لكن الاختيار لا فئاتيتم تقسيم المجتمع إلى :التعريف

 .يكون عشوائياً

 .أسرع وأقل تكلفة من العينة العشوائية الطبقية✅.تضمن تمثيل الفئات المختلفة في المجتمع✅:المزايا

 .الباحثعرضة للتحيز بسبب اختيار الأفراد وفقاً لرأي :العيوب

% 50% من الرجال و50، يمكنك اختيار آراء المستهلكين حول منتج جديدإذا كنت تجري بحثاً عن :مثال

 .من النساء، لكن بطريقة غير عشوائية

 (ConvenienceSampling) عينة الصدفة .3

 .، دون معايير محددةمدى سهولة الوصول إليهميتم اختيار الأفراد بناءً على :التعريف

 .منخفضة التكلفة✅.سريعة وسهلة التنفيذ✅:المزايا

 .يمكن أن تكون متحيزة❌.غير موثوقة لأن العينة قد لا تمثل المجتمع❌:العيوب

، يمكنك اختيار الطلاب المتاحين في الكافيتيريا دون أي جامعة معينةإذا كنت تجري دراسة في :مثال

 .معايير محددة

 (VoluntarySampling) العينة التطوعية .4

 .في البحث يوافقون طواعية على المشاركةيتم اختيار الأفراد الذين :تعريفال

 .سهلة التنفيذ ولا تتطلب جهداً في البحث عن المشاركين:المزايا

 .قد تكون النتائج غير دقيقة لأن المشاركين قد يكون لديهم دوافع معينة للمشاركة:العيوب

 :مثال
 .عليه فقط من يرغبون في المشاركةإجراء استبيان عبر الإنترنت، حيث يجيب 

 مقارنة بين العينات الاحتمالية وغير الاحتمالية��



 العينات غير الاحتمالية العينات الاحتمالية المعيار

 غير عشوائية عشوائية طريقة الاختيار

 منخفضة عالية إمكانية التعميم

 مرتفع منخفض التحيز

 وأسرعأسهل  صعبة وتحتاج وقتاً سهولة التنفيذ

 منخفضة مرتفعة التكلفة

 كيفية اختيار نوع العينة المناسبة؟��

 .العينات الاحتماليةاستخدم →إذا كنت تريد تعميم النتائج على المجتمع بالكامل✅

 .العينات غير الاحتماليةاستخدم →إذا كنت تجري دراسة استكشافية أو لديك قيود في الوقت والموارد✅

 الخاتمة��

العينة من أهم مراحل البحث العلمي، ويؤثر بشكل مباشر على دقة وموثوقية النتائج. تعتمد يعُد اختيار 

 .طريقة الاختيار على طبيعة البحث، وحجم المجتمع، والإمكانات المتاحة للباحث

ما هو نوع العينة الذي تعتقد أنه الأنسب لدراسة تأثير وسائل التواصل الاجتماعي على :سؤال للنقاش��

 ��الجامعات؟ ولماذا؟طلاب 

 

 

 

 التحليل الإحصائي في البحث العلميالمحاضرة الثالثة 

 أنواع التحليل الإحصائي في البحث العلمي

 مقدمة��

تنظيم البيانات، يعُد التحليل الإحصائي أحد الأدوات الأساسية في البحث العلمي، حيث يساعد على 

من خلال تطبيق الأساليب الرياضية والإحصائية عليها. يسُتخدم  تفسيرها، والتوصل إلى استنتاجات

 .العلوم الاجتماعية، الاقتصاد، الطب، التربية، وغيرهاالتحليل الإحصائي في مختلف المجالات مثل 

 :يقسم التحليل الإحصائي إلى نوعين رئيسيين��

 (Descriptive Statistics) التحليل الإحصائي الوصفي1️⃣

 (InferentialStatistics) الإحصائي الاستدلاليالتحليل 2️⃣

: التحليل الإحصائي الوصفي��  (Descriptive Statistics) أولاا



 .يسُتخدم لوصف وتلخيص البيانات دون التطرق إلى استنتاجات تتجاوز العينة المدروسة��

 (Measures of Central Tendency) مقاييس النزعة المركزية .1

 :، وتشملالقيمة التي تمثل البيانات بشكل عامتهدف إلى تحديد ��

 المتوسط الحسابي (Mean) = مجموع القيم / عددها. 
 الوسيط (Median) = ًالقيمة التي تقع في المنتصف عند ترتيب القيم تصاعدياً أو تنازليا. 

 المنوال (Mode) = أكثر قيمة تتكرر في البيانات. 

 :مثال��

 90، 90، 80، 70، 60 :تبار هيإذا كانت درجات خمسة طلاب في اخ

 78تساوي  5 ÷ (90 + 90 + 80 + 70 + 60) المتوسط الحسابي  

 80الوسيط 
 لأنه أكثر القيم تكرارًا90المنوال. 

 (Measures of Dispersion) مقاييس التشتت .2

 :تسُتخدم لمعرفة مدى انتشار القيم حول المتوسط الحسابي، وتشمل��

 المدى (Range) =  أكبر وأصغر قيمة في البياناتالفرق بين. 

 الانحراف المعياري (Standard Deviation) = مدى تباعد القيم عن المتوسط الحسابي. 

 التباين (Variance) = مربع الانحراف المعياري. 

 :مثال��

 90، 70، 50إذا كانت درجات الطلاب 

 40تساوي  50 - 90 المدى 

 ادلة الرياضية، وهو يعكس مدى انتشار البياناتيتم حسابه باستخدام المع الانحراف المعياري. 

 (Frequency Distribution & Graphs) التوزيع التكراري والرسوم البيانية .3

 .تسُتخدم لتنظيم البيانات بطريقة تساعد على فهمها بسهولة��

 :أهم التمثيلات البيانية��

 .المئويةتسُتخدم لتمثيل النسب →(Pie Charts) المخططات الدائرية✅

 .تسُتخدم للمقارنة بين الفئات→(Bar Charts) المخططات العمودية✅

 .يسُتخدم لتمثيل التوزيع التكراري للبيانات→(Histogram) المدرج التكراري✅

 :مثال��

إذا كان لديك بيانات عن عدد الطلاب في أقسام الجامعة، يمكنك عرضها باستخدام مخطط دائري لإظهار 

 .نسبة كل قسم



 (InferentialStatistics) ثانياا: التحليل الإحصائي الاستدلالي��

 .يسُتخدم لاستخلاص استنتاجات حول المجتمع من خلال تحليل العينة المدروسة��

 (HypothesisTesting) اختبارات الفرضيات .1

 .تسُتخدم لاختبار صحة الفرضيات الإحصائية حول المجتمع��

 :أهم الاختبارات الإحصائية��

 .لمقارنة متوسطين ومعرفة ما إذا كان الفرق بينهما دالًا إحصائياً:(T-Test) اختبار✅

 .لمقارنة أكثر من متوسطين في المجموعات المختلفة:(ANOVA) اختبار✅

 .لتحليل العلاقة بين المتغيرات النوعية )مثل الجنس والتخصص(:(Chi-Square) اختبار✅

 :مثال��

، يمكنك استخدام هناك فرق في متوسط درجات الطلاب بين الذكور والإناثان إذا كنت تريد معرفة ما إذا ك

 .T-Test اختبار

 (CorrelationAnalysis) تحليل الارتباط .2

 .قوة العلاقة بين متغيرينيسُتخدم لقياس 

 :أنواع الارتباط��

 .كلما زاد أحد المتغيرات، زاد الآخر:(Positive Correlation) ارتباط طردي✅

 .كلما زاد أحد المتغيرات، قلّ الآخر:(NegativeCorrelation) ارتباط عكسي✅

 .لا يوجد نمط واضح بين المتغيرين:(No Correlation) عدم وجود ارتباط✅

 :مثال��

 باستخدام معامل ارتباط بيرسون عدد ساعات المذاكرة والدرجات في الاختباردراسة العلاقة بين 

(Pearson’s r). 

 (RegressionAnalysis) الانحدارتحليل  .3

 .بقيمة متغير معين بناءً على متغير آخرللتنبؤ  يسُتخدم

 :أنواع تحليل الانحدار��

 .إذا كان هناك متغير مستقل واحد:(Simple LinearRegression) الانحدار الخطي البسيط✅

 .من متغير مستقل إذا كان هناك أكثر:(Multiple LinearRegression) الانحدار الخطي المتعدد✅

 :مثال��

 .عدد ساعات الدراسةبناءً على  بدرجات الطلاب في الاختبار النهائيالتنبؤ 

 (ANOVA – Analysis of Variance) تحليل التباين .4



لمعرفة ما إذا كان هناك اختلاف ذو دلالة إحصائية  لمقارنة متوسطات أكثر من مجموعتينيسُتخدم ��

 .بينها

 :مثال��

، يمكنك استخدام مدارس مختلفة 3ما إذا كانت هناك فروق بين أداء الطلاب في إذا كنت تريد معرفة 

 .ANOVA تحليل

 

 مقارنة بين التحليل الوصفي والاستدلالي��

 التحليل الاستدلالي التحليل الوصفي العامل

 استنتاجات حول المجتمع وصف البيانات وتلخيصها الهدف

 التطبيقات
المتوسط، الانحراف المعياري، الرسوم حساب 

 البيانية

اختبار الفرضيات، تحليل الارتباط 

 والانحدار

طريقة 

 الاستخدام
 تطُبق على العينة ثم تعُمم على المجتمع تطُبق على البيانات مباشرة

 الخاتمة

رغب فقط في يعتمد اختيار نوع التحليل الإحصائي على طبيعة البحث والأسئلة المطروحة. إذا كنت ت��

حول المجتمع،  استنتاجات أعمق، فاستخدم التحليل الوصفي. أما إذا كنت ترغب في وصف البيانات

 .فاستخدم التحليل الاستدلالي

 :سؤال للنقاش��

ما هو نوع التحليل الإحصائي الذي تعتقد أنه الأنسب لدراسة تأثير عدد ساعات النوم على مستوى 

 التحصيل الدراسي؟ ولماذا؟

 مقارنة بين الأساليب الإحصائية المختلفة��

 الأدوات المستخدمة يسُتخدم في الأسلوب

 وصف وتلخيص البيانات التحليل الوصفي
مقاييس النزعة المركزية، مقاييس التشتت، 

 الرسوم البيانية

 ، كاي مربعT ،ANOVA اختبار اختبار صحة فرضيات البحث اختبارات الفرضيات

 معامل ارتباط بيرسون العلاقة بين متغيرين قياس تحليل الارتباط

 الانحدار البسيط والمتعدد التنبؤ بقيمة متغير بناءً على آخر تحليل الانحدار

 تحليل التباين
مقارنة متوسطات أكثر من 

 مجموعتين
 ANOVA تحليل

تحليل البيانات 

 النوعية

دراسة المعاني داخل البيانات غير 
 الرقمية

التحليل الموضوعي، التحليل تحليل المحتوى، 
 السردي



 الخاتمة��

إذا كنت بحاجة إلى  .يختلف اختيار أسلوب التحليل الإحصائي حسب طبيعة البيانات وأهداف البحث��

وصف البيانات، استخدم التحليل الوصفي. وإذا كنت بحاجة إلى استخلاص استنتاجات وتعميمها، استخدم 

 .التحليل الاستدلالي

 :للنقاشسؤال ��

 ما هو الأسلوب الإحصائي الذي تعتقد أنه الأكثر استخدامًا في بحوث التربية والتعليم؟ ولماذا؟

 في البحث العلمي (Questionnaire) الاستبيان:  الرابعة محاضرة

 تعريف الاستبيان��

تتكون من مجموعة من الأسئلة المكتوبة التي تقُدم للمشاركين للإجابة  أداة لجمع البياناتالاستبيان هو ��

آراء أو معلومات من عدد كبير من عنها. يسُتخدم في الأبحاث الكمية والنوعية، خاصة عند الحاجة إلى 

 .بطريقة موحدة وسريعة الأفراد

 أهمية الاستبيان في البحث العلمي��

 .على عدد كبير من المشاركين بسهولةيمكن توزيعه  :فعال من حيث التكلفة✅

 .يمكن تحويله إلى بيانات رقمية قابلة للتحليل الإحصائي :سهل التحليل✅

 .يسمح بمقارنة إجابات الأفراد :يوفر بيانات معيارية✅

 .حيث لا يكون هناك تفاعل مباشر قد يؤثر على الإجابات :يقلل من تأثير الباحث✅

 أنواع الاستبيان��

 .الاستبيانات بناءً على طريقة طرح الأسئلة، وطريقة التوزيع، ونوع البيانات المطلوبة يمكن تصنيف��

 حسب نوع الأسئلة1️⃣

 (Closed-ended Questionnaire) الاستبيان المغلق✅

 .(Likert Scale) نعم / لا(، أو مقياس ليكرت)يتضمن أسئلة ذات إجابات محددة مسبقاً، مثل ��

 :مثال��

 "الهاتف الذكي يومياً؟هل تستخدم "

 نعم��

 لا��

 :المزايا��

 .سهل التحليل✔



 .يقلل التحيز في الإجابات✔

 .يسمح بجمع بيانات قابلة للقياس الكمي✔

 :العيوب��

 .قد لا يسمح بالتعبير عن وجهات النظر بحرية❌

 (Open-ended Questionnaire) الاستبيان المفتوح✅

 .بالإجابة بحرية دون خيارات محددةيتضمن أسئلة تسمح للمستجيب ��

 :مثال��

 "ما هي العوامل التي تؤثر على استخدامك للهاتف الذكي؟"

 :المزايا��

 .يوفر بيانات تفصيلية وعميقة✔

 .يكشف عن أفكار غير متوقعة✔

 :العيوب��

 .صعب التحليل مقارنة بالأسئلة المغلقة❌

 .قد يستغرق وقتاً أطول للإجابة عليه❌

 (Mixed Questionnaire) الاستبيان المختلط✅

 .يجمع بين الأسئلة المغلقة والمفتوحة للحصول على بيانات كمية وكيفية��

 :المزايا��

 .يجمع بين الدقة الإحصائية والتفصيل النوعي✔

 .يوفر نظرة شاملة حول الموضوع✔

 :العيوب��

 .قد يكون أكثر تعقيداً عند التحليل❌

 التوزيعحسب وسيلة 2️⃣

 (Paper-based Questionnaire) الاستبيان الورقي✅

 .يتم توزيعه وملؤه يدوياً، مثل الاستبيانات المطبوعة��

 (Online Questionnaire) الاستبيان الإلكتروني✅

 .أو منصات أخرىSurveyMonkeyأو Google Formsيتم إرساله عبر الإنترنت باستخدام ��

 (Telephone Survey) الاستبيان الهاتفي✅

 .بدلاً من الكتابة المكالمات الهاتفيةيتم جمع البيانات عبر ��



 (Mailed Questionnaire) الاستبيان البريدي✅

 .يتم إرساله بالبريد العادي ويتطلب إعادته بعد الإجابة��

 :مقارنة بين الأنواع المختلفة��

 العيوب المزايا نوع الاستبيان

 مكلف، يحتاج وقتاً أطول بعض المؤسساتأكثر رسمية، مناسب في  ورقي

 يتطلب اتصالًا بالإنترنت سريع، منخفض التكلفة، سهل التحليل إلكتروني

 قد يكون مزعجًا لبعض المشاركين مناسب عند الحاجة إلى استجابات سريعة هاتفي

 الاستجابةبطيء، يتطلب متابعة لضمان  مناسب للمناطق التي لا تعتمد على الإنترنت بريدي

 خطوات تصميم الاستبيان الناجح��

 :لضمان جمع بيانات دقيقة وموثوقة، يجب اتباع الخطوات التالية��

 تحديد الهدف من الاستبيان1️⃣

 ما الذي تريد معرفته من خلال هذا الاستبيان؟��

 ما هي الأسئلة التي ستساعدك في الإجابة على سؤال البحث؟��

 :مثال��

 :، فقد يكون الهدفأثر وسائل التواصل الاجتماعي على التحصيل الدراسيإذا كنت تجري بحثاً حول 

 ."قياس مدى تأثير استخدام مواقع التواصل على تركيز الطلاب وأدائهم الأكاديمي"

 تحديد نوع الأسئلة وصياغتها2️⃣

 .يجب أن تكون الأسئلة واضحة، مباشرة، وحيادية✅

 .الطويلة أو المزدوجةتجنب الأسئلة ✅

 .استخدم لغة بسيطة ومفهومة✅

 :مثال على سؤال سيئ��

 "هل تعتقد أن استخدام مواقع التواصل الاجتماعي يؤثر على الدراسة ويقلل من الإنتاجية ويسبب الإدمان؟"

 .يحتوي على أكثر من فكرة، مما قد يربك المستجيب❌

 :مثال على سؤال جيد��

 "ع التواصل الاجتماعي على تركيزك أثناء الدراسة؟كيف يؤثر استخدام مواق"

 تحديد مقياس الإجابة3️⃣



 :يمكن استخدام مقاييس مثل��

 .على بيان معين درجة موافقتهميتيح للمستجيبين اختيار  :(Likert Scale) مقياس ليكرت✅

 :مثال��

 "أستخدم وسائل التواصل الاجتماعي أثناء الدراسة"

 لا أوافق بشدة��

 أوافقلا ��

 محايد��

 أوافق��

 أوافق بشدة��

 .نعم / لامثل  :(BinaryChoice Questions) الأسئلة ثنائية الاختيار✅

 .(Multiple Choice Questions) الأسئلة متعددة الخيارات✅

 (Pilot Study) اختبار الاستبيان4️⃣

قبل التوزيع على العينة  عدد قليل من المشاركينلاختبار الاستبيان مع  دراسة تجريبيةيجب إجراء ��

 .الكاملة

 :الهدف من ذلك��

 .التأكد من وضوح الأسئلة✔

 .اكتشاف أي مشاكل في الصياغة أو التصميم✔

 توزيع الاستبيان وجمع البيانات5️⃣

 .(ورقي، إلكتروني، هاتفي، بريدي)استخدم الوسيلة المناسبة لتوزيع الاستبيان ��

 .على نسبة استجابة عاليةتابع المشاركين لضمان الحصول ��

 تحليل البيانات6️⃣

 .Excel أو SPSSوبرامج مثل  الإحصاء الوصفييتم تحليلها باستخدام  الأسئلة المغلقة��

 .لتحديد الأنماط والأفكار المتكررة تحليل المحتوىيتم تحليلها باستخدام  الأسئلة المفتوحة��

 مميزات وعيوب الاستبيان��

 العيوب المميزات

التطبيق ويمكن توزيعه على عدد كبير من سهل 
 المشاركين

 قد يجيب المشاركون بشكل غير دقيق أو غير جاد

 لا يسمح بتوضيح الأسئلة أو تقديم استفسارات إضافية سريع في جمع البيانات وتحليلها

يمكن أن يكون مجهولًا، مما يشجع على  الاستبيانات قد يكون معدل الاستجابة منخفضًا )خاصة في 



 العيوب المميزات

 الإلكترونية( الصراحة

 الخاتمة��

تصميمه الجيد، ووضوح أسئلته، واختيار أداة فعالة لجمع البيانات، ولكن نجاحه يعتمد على  الاستبيان��

لضمان دقة  اختباره وتحليل نتائجه بعنايةقبل استخدامه، من الضروري  .الطريقة المناسبة لتوزيعه

 .البحث العلمي

 :سؤال للنقاش��

 لجمع آراء الطلاب حول تجربة التعلم عن بعُد؟ ولماذا؟ أفضل نوع استبيانما هو برأيك 

 (Questionnaire Components) عناصر الاستبيان)محاضرة ( 

من عدة عناصر أساسية تضمن تنظيمه وسهولة قراءته وإجابته من قبل المشاركين.  الاستبيانيتكون ��

 .يجب أن تكون هذه العناصر واضحة ومترابطة لضمان جمع بيانات دقيقة وموثوقة

 العناصر الأساسية للاستبيان��

 (Title) العنوان1️⃣

ا ودقيقاايجب أن يكون ��  .، بحيث يعكس موضوع البحثواضحا

 "استبيان حول تأثير وسائل التواصل الاجتماعي على التحصيل الدراسي لدى طلاب الجامعة" :مثال✅

 :نصائح✅

 .اجعله موجزًا ومحدداً✔

 .تجنب العناوين الغامضة أو الطويلة جداً✔

 (Introduction) المقدمة2️⃣

تعليمات حول كيفية تهدف المقدمة إلى تقديم الاستبيان للمشاركين، وشرح الهدف منه، وإعطائهم ��

 .الإجابة

 :يجب أن تتضمن✅

 .(لماذا يتم جمع هذه البيانات؟)الغرض من الدراسة✔

 .(هل هي اختيار من متعدد، مقياس ليكرت، إلخ؟)طبيعة الأسئلة✔

تأكيد أن الإجابات ستبقى مجهولة ولن تسُتخدم إلا لأغراض )معلومات عن السرية والخصوصية✔

 .(البحث

 .(كم سيستغرق المشارك في الإجابة؟)المتوقعةمدة الإجابة ✔



 :مثال��

 عزيزي المشارك، 

نحن مجموعة من الباحثين نجُري دراسة حول تأثير وسائل التواصل الاجتماعي على التحصيل الدراسي. 

دقائق من وقتك. جميع إجاباتك  5نود أن نطلب منك المشاركة في هذا الاستبيان الذي لن يستغرق أكثر من 

 "!سرية تمامًا، ولن تسُتخدم إلا لأغراض البحث الأكاديمي. نشكرك على وقتك ومساهمتك القيمةستظل 

 (Demographic Information) المعلومات الديموغرافية3️⃣

 :، مثلخصائص المشاركينتحتوي هذه الأسئلة على معلومات حول ��

 العمر✅

 الجنس✅

 المستوى التعليمي✅

 المهنة✅

 مكان الإقامة✅

 :مثال��

 :العمر��

 سنة 18أقل من ��

 سنة 18-25 ��

 سنة 26-35 ��

 سنة 35أكثر من ��

 :نصائح✅

 .اجعل الأسئلة اختيارية إذا لم تكن ضرورية للتحليل✔

 .لا تجمع معلومات شخصية غير ضرورية✔

 (Main Questionnaire Questions) أسئلة الاستبيان الرئيسية4️⃣

 .من الاستبيان، حيث يتم جمع البيانات الفعلية حول موضوع البحث الجزء الأساسيتمثل ��

 :أنواع الأسئلة الشائعة✅

 :(Closed-ended Questions) الأسئلة المغلقة1️⃣

 كم ساعة تقضيها يومياً على وسائل التواصل الاجتماعي؟" :مثال" 

 أقل من ساعة��

 ساعات 1-3 ��

 ساعات 3أكثر من ��

 :(Open-ended Questions) الأسئلة المفتوحة2️⃣



 كيف تؤثر وسائل التواصل الاجتماعي على دراستك؟" :مثال" 

 :(Likert Scale Questions) مقياس ليكرت3️⃣

 إلى أي مدى توافق على العبارة التالية: وسائل التواصل الاجتماعي تساعدني على تحسين " :مثال

 "تحصيلي الدراسي؟

 لا أوافق بشدة��

 لا أوافق��

 محايد��

 أوافق��

 أوافق بشدة��

 :نصائح✅

 .تأكد من أن الأسئلة واضحة وغير متحيزة✔

 .استخدم لغة بسيطة وسهلة الفهم✔

 .تجنب الأسئلة الطويلة أو المربكة✔

 .رتب الأسئلة من الأسهل إلى الأكثر تعقيداً✔

 (ClosingStatement) شكر وتوضيح النهاية5️⃣

 .بطريقة احترافية ومحفزةيسُتخدم لإنهاء الاستبيان ��

 :يجب أن يتضمن✅

 .على وقته وإجاباته شكر المشارك✔

 .(إذا كان هناك متابعة أو نتائج سيتم نشرها)توضيح كيفية استخدام البيانات✔

 .(إذا كان بإمكان المشارك التواصل مع الباحث لمزيد من التفاصيل)معلومات إضافية✔

 :مثال��

ومشاركتك في هذا الاستبيان. سيتم استخدام إجاباتك لتحليل تأثير وسائل  شكرًا جزيلاً على وقتك" ��

التواصل الاجتماعي على التحصيل الدراسي. إذا كنت مهتمًا بنتائج البحث، يمكنك التواصل معنا عبر 

 "!نتمنى لك يومًا سعيداً .research@university.edu :البريد الإلكتروني

 التصميم الجيد للاستبيان��

ا قدر الإمكان✅  .(دقيقة كحد أقصى 15-5)اجعل الاستبيان قصيرا

ا✅ ا ومنظما ا واضحا  .(عناوين فرعية، مسافات بين الأسئلة)استخدم تصميما

 .(Pilot Study)اختبره على عينة صغيرة قبل التوزيع الرسمي✅

 الخاتمة��



ات الديموغرافية، الأسئلة العنوان، المقدمة، المعلوميتكون الاستبيان من عدة عناصر أساسية، مثل ��

ا وسهل الفهميجب أن يكون كل عنصر  .الرئيسية، والخاتمة  .لضمان جمع بيانات دقيقة وموثوقة واضحا

 :سؤال للنقاش✅

 �� ما هي التحديات التي قد تواجهها عند تصميم استبيان لموضوع معين؟

  

 

 

 

 في التحليل الإحصائي SPSS : برنامجمحاضرة الخامسة 

 ؟SPSS برنامجما هو ��

🔹SPSS (Statistical Package for the Social Sciences) هو أحد أكثر البرامج استخدامًا في

العلوم الاجتماعية، والاقتصاد، والتربية، والصحة، التحليل الإحصائي، ويستخدم على نطاق واسع في 

الإحصائية، وعرض النتائج في بإدخال البيانات، وإجراء التحليلات للباحثين  SPSS يسمح .والأعمال

 .شكل جداول ورسوم بيانية

 SPSS أهمية برنامج��

يتميز بواجهة رسومية تسهل إدخال البيانات وتحليلها دون الحاجة إلى كتابة أكواد  :سهولة الاستخدام✅

 .برمجية معقدة

 .يوفر أدوات إحصائية قوية للحصول على نتائج موثوقة :دقة التحليل✅

 .يمكنه تحليل آلاف البيانات بسرعة :يات كبيرة من البياناتالتعامل مع كم✅

 .مثل الجداول والرسوم البيانية والتقارير الإحصائية :إخراج النتائج بصيغ متعددة✅

 SPSS واجهة برنامج��

 :، تظهر عدة نوافذ رئيسية، منهاSPSS عند فتح��

 (Data View) نافذة إدخال البيانات1️⃣

 .يتم إدخال البيانات في صفوف )تمثل الحالات( وأعمدة )تمثل المتغيرات( ، حيثExcelتشبه ورقة ✅

 .كل خلية تمثل قيمة لمتغير معين في حالة معينة✅

 (Variable View) نافذة تعريف المتغيرات2️⃣



 :تحتوي على معلومات حول المتغيرات، مثل✅

 (Variable Name)اسم المتغير✔

 (Numeric, String)نوع المتغير✔

 (Scale, Ordinal, Nominal)وحدات القياس✔

 وصف إضافي للمتغير :(Label) التسمية✔

 تعيين القيم غير المسجلة :(Missing Values) قيم مفقودة✔

 (Output Window) نافذة المخرجات3️⃣

 .تعرض نتائج التحليل الإحصائي مثل الجداول والرسوم البيانية والتقارير الإحصائية✅

 SPSS البيانات فيإدخال ��

 .، أو قواعد بيانات أخرىExcel ،CSVيمكن إدخال البيانات يدوياً أو استيرادها من ��

 :مثال على إدخال بيانات دراسة حول تأثير وسائل التواصل الاجتماعي على التحصيل الدراسي✅

ID الجنس المعدل الأكاديمي عدد ساعات استخدام السوشيال ميديا العمر 

 ذكر 15 3 20 1

 أنثى 12 5 22 2

 ذكر 16 2 19 3

 .Variable View، بينما يتم تعريف المتغيرات في Data Viewيتم إدخال هذه البيانات في ��

 SPSS التحليل الإحصائي باستخدام��

 :يوفر البرنامج العديد من الأساليب الإحصائية، من بينها��

 (Descriptive Statistics) الإحصاء الوصفي1️⃣

 .المتوسط الحسابي، الوسيط، المنوال، التباين، والانحراف المعياريلحساب ✅

 :الطريقة��

🔹Analyze→ Descriptive Statistics→Frequenciesأو Descriptives 

 

 (HypothesisTesting) اختبارات الفرضيات2️⃣

 .(Chi-Square) ، اختبار كايسكوير(ANOVA) ، تحليل التباينT اختبارمثل ✅

 :الطريقة��



 

🔹Analyze→ Compare Means (لاختبار T) 

🔹Analyze→ General Linear Model (لتحليل التباين) 

 (CorrelationAnalysis) تحليل الارتباط3️⃣

 .لقياس العلاقة بين متغيرين )مثل العلاقة بين عدد ساعات استخدام الهاتف والتحصيل الدراسي(✅

 :الطريقة��

🔹Analyze→Correlate→Bivariate 

 

 (RegressionAnalysis) تحليل الانحدار4️⃣

 .يستخدم لتوقع القيم المستقبلية بناءً على متغيرات مستقلة✅

 :الطريقة��

🔹Analyze→Regression→Linear 

 

 (Graphs) إنشاء الرسوم البيانية��

 :أدوات لإنشاء رسوم بيانية مثل SPSS يوفر��

 (Bar Charts) الرسوم البيانية العمودية✅

 (Pie Charts) المخططات الدائرية✅

 (Scatter Plots) المخططات التشتتية✅

 :الطريقة��

🔹Graphs → Chart Builder 

 

 

 

 SPSS مزايا وعيوب برنامج��

 العيوب المزايا

 مكلف مقارنة ببعض البرامج الأخرى واجهة سهلة الاستخدام

 Python أو R بعض التحليلات المعقدة مقارنة بـمحدود في  مناسب للتحليل الإحصائي المتقدم



 العيوب المزايا

 يتطلب تدريباً لاستخدامه بكفاءة يدعم البيانات الكبيرة

 

 الخاتمة��

📌SPSS تنظيم البيانات، تحليلها، وإنتاج تقارير هو أداة قوية للتحليل الإحصائي، تساعد الباحثين في

ا جيداا للإحصاء وأساسيات يتطلب  .إحصائية دقيقة  .لتحقيق أقصى استفادة منه التعامل مع البرنامجفهما

 :سؤال للنقاش✅

 لأول مرة؟ SPSS التي قد تواجه الباحث عند استخدام أهم التحدياتما هي 

 Data View إدخال البيانات في1️⃣

 .Excel حيث يتم إدخال البيانات في صفوف وأعمدة مثلData View، ستجد نافذة SPSS عند فتح��

ا، وكل (Participant) حالةصف يمثل كل ��  .(Variable) عمود يمثل متغيرا

 Variable View تعريف المتغيرات في2️⃣

، يمكنك تسمية المتغيرات وتحديد نوعها )رقمي، نصي، إلخ( وتحديد وحدات Variable Viewفي ��

 .(Nominal, Ordinal, Scale) القياس

 (Descriptive Statistics) الإحصاء الوصفي3️⃣

 :للحصول على المتوسط، الانحراف المعياري، والمدى، يمكن اتباع��

🔹Analyze→ Descriptive Statistics→Frequenciesأو Descriptives 

 T-Test اختبار -اختبار الفرضيات 4️⃣

 :لاختبار الفرق بين متوسط مجموعتين��

🔹Analyze→ Compare Means→ Independent-Samples T Test 

 (CorrelationAnalysis) الارتباطتحليل 5️⃣

 :لقياس العلاقة بين متغيرين��

🔹Analyze→Correlate→Bivariate 

 (Graphs) إنشاء الرسوم البيانية6️⃣

 :لإنشاء مخططات بيانية مثل الأعمدة والدائرية��

🔹Graphs → Chart Builder 



 بالتفصيل SPSS واجهة برنامج��

لأول مرة، ستظهر لك عدة نوافذ وأقسام رئيسية، كل منها يؤدي دورًا محدداً في SPSSعند فتح برنامج 

 .إدخال البيانات، تحليلها، وعرض النتائج

 SPSS المكونات الرئيسية لواجهة��

 :أربع نوافذ رئيسيةمن  SPSS يتكون

 (Data View) نافذة عرض البيانات1️⃣

 (Variable View) نافذة تعريف المتغيرات2️⃣

 (Output Window) نافذة المخرجات3️⃣

 (Syntax Editor) نافذة محرر الأوامر4️⃣

التي تسهل الوصول إلى  شريط القوائم، شريط الأدوات، وشريط الحالةبالإضافة إلى ذلك، يحتوي على ��

 .الأدوات المختلفة

 (Data View) نافذة عرض البيانات1️⃣

حيث يتم تمثيل البيانات  Excel تشبه ورقة.البيانات وتعديلهاهذه النافذة هي المكان الأساسي لإدخال ��

 :في صفوف وأعمدة

 .يمثل حالة أو مشاركًا في البحث(Row) كل صف✅

 .يمثل متغيرًا )مثل العمر، الجنس، الدرجة، عدد الساعات((Column) كل عمود✅

 

 

 :Data View مثال على البيانات في✅

ID المعدل الأكاديمي عدد ساعات الدراسة الجنس العمر 

 15 3 ذكر 20 1

 12 5 أنثى 22 2

 16 2 ذكر 19 3

 .يمكن تعديل القيم بسهولة عبر النقر المزدوج على الخلايا��

 (Variable View) نافذة تعريف المتغيرات2️⃣

تتكون هذه النافذة من عدة أعمدة، كل .في الدراسة (Variable) هنا يتم تحديد خصائص كل متغير��

 :يحتوي على معلومات محددة عن المتغيرات مثلمنها 

 .(Age ،Gender ،Score مثل) اسم المتغير:(Name) الاسم✔



 .(String) أم نصي (Numeric) هل هو رقمي:(Type) النوع✔

 .وصف إضافي لمساعدة الباحثين )مثل "عمر الطالب"(:(Label) التسمية✔

 .ية التعامل مع البيانات غير المكتملةتحديد كيف:(Missing Values) القيم المفقودة✔

 .(Nominal ،Ordinal ،Scale) نوع المقياس المستخدم:(Measure) المقياس✔

 :مثال على إعداد المتغيرات✅

Name Type Label Values Measure 

Age Numeric عمر المشارك - Scale 

Gender String أنثى 2ذكر,  = 1 الجنس = Nominal 

Score Numeric المعدل الأكاديمي - Scale 

 (Output Window) نافذة المخرجات3️⃣

 .هذه النافذة تظهر جميع النتائج الإحصائية بعد تشغيل أي تحليل��

 .لتحليلك الإحصائي الجداول، المخططات، والنتائج النهائيةتحتوي على ✅

 .التقارير الأكاديميةلاستخدامها في Excel ، أوPDF ،Wordيمكن حفظ النتائج بصيغة ✅

 :مثال على نتيجة تحليل إحصائي✅

 (N) العدد الانحراف المعياري المتوسط الحسابي المتغير

 100 2.3 21.5 العمر

 100 1.5 4.2 عدد الساعات الدراسية

 .يمكنك أيضًا إنشاء رسوم بيانية ومخططات بيانية من هذه النافذة��

 SPSS شريط القوائم والأدوات في)محاضرة (

 :الذي يوفر جميع الأدوات والإعدادات الضرورية شريط القوائم، يوجد SPSS في أعلى واجهة��

 الوظيفة القائمة

File فتح، حفظ، أو تصدير الملفات 

Edit تعديل البيانات، التراجع، النسخ واللصق 

View تخصيص طريقة عرض البيانات والأوامر 

Data  والتصفيةإدارة البيانات مثل الفرز 

Transform تحويل البيانات وإجراء العمليات الحسابية 

Analyze تشغيل الاختبارات الإحصائية المختلفة 

Graphs إنشاء الرسوم البيانية والمخططات 



 الوظيفة القائمة

Utilities أدوات إضافية مثل تعريفات المتغيرات 

Window إدارة النوافذ المفتوحة 

Help  والمساعدةالوصول إلى دليل المستخدم 

 :مثال على استخدام القائمة✅

 :، نذهب إلىالإحصاء الوصفيلاستخراج ��

🔹Analyze→ Descriptive Statistics→Frequencies 

 :يحتوي على واجهة منظمة وسهلة الاستخدام، تتكون منSPSSبرنامج ��

 .لإدخال البيانات(Data View) نافذة عرض البيانات1️⃣

 .لتحديد خصائص المتغيرات(Variable View) المتغيراتنافذة تعريف 2️⃣

 .لعرض النتائج الإحصائية(Output Window) نافذة المخرجات3️⃣

 .لكتابة الأوامر البرمجية(Syntax Editor) محرر الأوامر4️⃣

 .للوصول بسرعة إلى الميزات المختلفة شريط القوائم والأدواتبالإضافة إلى ذلك، يمكن استخدام ��

 :سؤال للنقاش✅

  ؟ هل لديك أي استفسارات حول استخدامه؟SPSS ما هي أكثر ميزة تجدها مفيدة في

 بالتفصيل SPSS في )Variable View (نافذة تعريف المتغيرات)محاضرة ( 

تحديد ، حيث يتم فيها SPSS برنامجمن أهم النوافذ في (Variable View) نافذة تعريف المتغيراتتعُد 

 .التي سيتم تحليلها في البحث المتغيراتخصائص 

 :وظيفتها��

 .تسمية المتغيرات وتحديد نوع البيانات لكل متغير✅

 .(Nominal, Ordinal, Scale) تحديد وحدات القياس✅

 .ضبط القيم المفقودة وتنسيق عرض البيانات✅

 كيفية الوصول إلى نافذة تعريف المتغيرات؟1️⃣ ��

 .SPSSافتح برنامج 1️⃣

 :، ستجد خيارينأسفل نافذة البياناتانتقل إلى 2️⃣

 Data View (عرض البيانات) 

 Variable View (عرض المتغيرات) 

 .صفوف وأعمدةوستظهر لك نافذة تحتوي على Variable Viewانقر على 3️⃣

 



 

 

 SPSS مكونات نافذة المتغيرات في2️⃣ ��

ا صف يمثلمن عدة أعمدة، وكل  نافذة تعريف المتغيراتتتكون  عمود يحدد خصائص ، بينما كل متغيرا

 .المتغير

 وظيفته العمود

Name (الاسم) اسم المتغير (مثل Age ،Gender). 

Type (النوع) )نوع البيانات )رقمي، نصي، تاريخ، إلخ. 

Width (العرض) عدد الأحرف أو الأرقام الممكنة. 

Decimals (الأرقام العشرية)  المعروضةعدد المنازل العشرية. 

Label (التسمية) )"وصف المتغير )مثلاً "العمر بالسنوات. 

Values (القيم)  ًأنثى(2=ذكر، 1تعيين رموز للبيانات الفئوية )مثلا=. 

Missing (القيم المفقودة) تحديد القيم التي سيتم اعتبارها مفقودة. 

Columns (الأعمدة) عرض عمود المتغير في Data View. 

Align (المحاذاة) )محاذاة البيانات داخل الخلية )يمين، يسار، وسط. 

Measure (المقياس) نوع القياس (Nominal ،Ordinal ،Scale). 

 (Name) اسم المتغير .1 ��

ا✅ ا فريدا  .(لا يتكرر)يجب أن يكون اسما

 .(يمكن استخدام _ بدلاً من المسافات)مسافات أو رموز خاصةلا يمكن أن يحتوي على ✅

 :مثال✅

 صحيح: Age, Gender, Score 

 ❌خاطئ: Age of Student (لا يحتوي على مسافات) 

 (Type) نوع المتغير .2 ��

 :يحدد نوع البيانات التي سيتم إدخالها، مثل

 الوصف النوع

Numeric )بيانات رقمية )مثلاً العمر، العلامات. 

String )بيانات نصية )مثل الأسماء، العناوين. 

Date )بيانات زمنية )مثل التواريخ. 



، فسيكون أسماءهم، أما إذا كنت تسجل Numericالنوع، فسيكون عمر الطلابإذا كنت تسجل :مثال✅

 .String النوع

 (Decimals) والأرقام العشرية (Width) العرض .3 ��

✅Width (العرض):يحدد عدد الأحرف المسموح بها للمتغير. 

✅Decimals (الأرقام العشرية):يحدد عدد المنازل العشرية في الأرقام. 

أما  .0بدون كسور، يمكن جعل الأرقام العشرية  100إلى  0من إذا كنت تسجل درجات الطلاب :مثال��

 .Decimals = 1(، فيمكنك تحديد 75.5لو كنت تريد تسجيل القيم بكسور عشرية )مثلاً 

 (Label) التسمية .4 ��

 .للمتغير لتسهيل قراءته وصف تفصيلييسمح بإضافة ✅

 :مثال✅

 Name: Age 

 Label:عمر الطالب بالسنوات 

 عند التعامل مع البيانات الفئوية - (Values) القيم .5 ��

 .للبيانات الفئوية )مثل الجنس، الحالة الاجتماعية( رموز رقميةيسُتخدم لإعطاء ✅

 SPSS مثال: إدخال الجنس في��

 الوصف القيمة الرقمية

 ذكر 1

 أنثى 2

 :SPSS لإدخال ذلك في��

 Valuesانقر على 1️⃣

 Define Valuesاضغط 2️⃣

 أنثى = 2و  ذكر = 1أدخل 3️⃣

 (Missing Values) القيم المفقودة .6 ��

 .حتى لا تؤثر على التحليل البيانات المفقودةتسُتخدم لتحديد ��

 :مثال✅

  كرمز للقيم المفقودة999إذا كان بعض المشاركين لم يذكروا عمرهم، يمكن وضع. 



 (Measure) المقياس .7 ��

 :يحدد نوع القياس المستخدم في البيانات

 الوصف نوع المقياس

Nominal )بيانات فئوية )مثل الجنس، الحالة الاجتماعية. 

Ordinal )بيانات ترتيبية )مثل مستوى التعليم: ابتدائي، متوسط، ثانوي. 

Scale  ،الوزن، الطول(بيانات كمية )مثل العمر. 

 :مثال عملي على تحديد المقياس✅

 الجنس (Male/Female)→Nominal 
 )الرتبة الوظيفية )مدير، مشرف، موظف→Ordinal 

 العمر بالسنوات→Scale 

 SPSS خطوات القيام بالتحليل الإحصائي للبيانات باستخدام)محاضرة ( 

وحتى  إدخال البياناتيتبع مجموعة من الخطوات المنظمة، بدءًا من SPSSالتحليل الإحصائي للبيانات في 

 .استخراج النتائج والتفسير

 SPSS الخطوات الأساسية للتحليل الإحصائي في��

 إعداد البيانات وتجهيزها1️⃣

 تنظيف البيانات والتأكد من جودتها2️⃣

 اختيار الاختبار الإحصائي المناسب3️⃣

 SPSS فيتشغيل التحليل الإحصائي 4️⃣

 استخراج النتائج وتفسيرها5️⃣

 عرض البيانات بطريقة واضحة )رسوم بيانية وجداول(6️⃣

 إعداد البيانات وتجهيزها1️⃣

 SPSS إدخال البيانات في��

 ."Data View"وانتقل إلى SPSSافتح برنامج ✅

 :أدخل البيانات في الصفوف والأعمدة، بحيث✅

 كل صف (Row) الدراسةيمثل مشاركًا أو حالة في. 

 كل عمود (Column)يمثل متغيرًا مثل العمر، الجنس، عدد الساعات الدراسية. 

 "Variable View" تعريف المتغيرات في��

 :وقم بتحديد"Variable View"انتقل إلى ✅

 اسم المتغير (Name) 



 نوع البيانات (Numeric, String, Date) 
 المقياس المستخدم (Nominal, Ordinal, Scale) 
 تسمية المتغير (Label)لسهولة التفسير 

 تنظيف البيانات والتأكد من جودتها2️⃣

 .قبل البدء في التحليل، يجب التأكد من أن البيانات نظيفة وخالية من الأخطاء��

 التأكد من عدم وجود بيانات مفقودة✅

  انتقل إلىAnalyze→ Descriptive Statistics→Frequencies 

  حدد المتغيرات وانقرOK 

  قيم مفقودةتحقق مما إذا كانت هناك 

 التأكد من صحة القيم المدخلة✅

  استخدم"Data → Sort Cases"للتحقق من وجود قيم غير متوقعة. 

 معالجة القيم المفقودة✅

  عبر (للعمر غير المعلوم 999مثلاا )يمكنك تعيين قيمة مفقودة"Variable 

View→Missing". 

 المناسباختيار الاختبار الإحصائي 3️⃣

 .يعتمد نوع التحليل على طبيعة البيانات والسؤال البحثي��

 التحليل الإحصائي المناسب نوع البيانات

 (Descriptive Statistics) الإحصاء الوصفي وصفية )مثل التوزيع، المتوسط، الوسيط(

 T-Test اختبار مقارنة متوسط مجموعتين

 ANOVA مقارنة متوسط أكثر من مجموعتين

 (Correlation) الارتباط دراسة العلاقة بين متغيرين كميين

 (RegressionAnalysis) الانحدار تحليل العلاقة بين متغيرين مع التأثيرات الأخرى

 (Chi-Square Test) اختبار كايسكوير تحليل العلاقة بين متغيرين فئويين

 :مثال✅

  استخدم →والإناثدرجات الطلاب الذكور إذا أردت معرفة الفرق بينT-Test 

  الارتباطاستخدم →عدد ساعات الدراسة والمعدل الأكاديميإذا أردت معرفة العلاقة بين 

 SPSS تشغيل التحليل الإحصائي في



 (Descriptive Statistics) مثال: إجراء تحليل وصفي��

 Analyze→ Descriptive Statistics→Frequenciesانتقل إلى 1️⃣

 .المطلوبة )مثلاً العمر، عدد الساعات الدراسية( اختر المتغيرات2️⃣

 :وحددStatisticsانقر 3️⃣

 المتوسط (Mean) 

 الوسيط (Median) 

 الانحراف المعياري (Std. Deviation) 

 .وستظهر النتائج في نافذة المخرجاتOKاضغط 4️⃣

 

 :مثال على نتائج التحليل الوصفي✅

 (N) العدد الانحراف المعياري المتوسط الحسابي المتغير

 100 2.3 21.5 العمر

 100 1.5 4.2 عدد الساعات الدراسية

 استخراج النتائج وتفسيرها5️⃣

 .(Output Window) المخرجاتفي نافذة  النتائجبعد تشغيل التحليل، تظهر ��

 :تفسير النتائج✅

  سنة 21.5متوسط عمر المشاركين هو ، فهذا يعني أن 21.5للعمر =  المتوسط الحسابيإذا كان. 

  معظم البيانات قريبة من المتوسط مع تفاوت ، فهذا يعني أن 2.3الانحراف المعياري = إذا كان

 .بسيط

 :(Correlation) تفسير العلاقة بين متغيرين باستخدام الارتباط✅

 التفسير (r) معامل الارتباط

 علاقة ضعيفة 0.30 - 0.00

 علاقة متوسطة 0.60 - 0.31

 قويةعلاقة  1.00 - 0.61

 SPSS مثال على تحليل الارتباط في�🖼�

 .علاقة قوية بين عدد ساعات الدراسة والمعدل الأكاديمي، فهذا يعني أن هناك r = 0.75 إذا كان✅

 عرض البيانات بطريقة واضحة )رسوم بيانية وجداول(6️⃣



 .لعرض النتائج بشكل أكثر وضوحًا مخططات بيانية وجداوليمكن إنشاء ��

 :SPSS رسم بياني فيلإنشاء ✅

 Graphs →LegacyDialogs→ Bar Chartانتقل إلى 1️⃣

 .(Pie Chart أو الدائرة Bar Chart الأعمدةاختر نوع المخطط )مثلاً 2️⃣

 .OKحدد المتغيرات المطلوبة واضغط 3️⃣

 :لنسب الطلاب حسب الجنس (Pie Chart) مثال على المخطط الدائري✅

 %60 :ذكر ��

 %40 :أنثى ��

 خاتمة

 :يتطلب اتباع الخطوات التالية SPSS إجراء التحليل الإحصائي في��

 Data View إدخال البيانات في1️⃣

 تنظيف البيانات والتأكد من جودتها2️⃣

 اختيار التحليل الإحصائي المناسب3️⃣

 Analyzeتشغيل التحليل عبر قائمة4️⃣

 تفسير النتائج بناءا على الجداول والمخرجات5️⃣

 دام الرسوم البيانية لتوضيح البياناتاستخ6️⃣
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